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Read This First, Before Something Bad Happens



I Had No Intentions of Writing This Book

(Actually, I mean the book that led to this book. Here's the story.) So here it was, about four weeks before I would be flying up to New York City to teach a one-day seminar to more than 1,200 professional Photoshop junkies. (Okay, it was more like 1,160 pros, 42 people who just wanted a paid day off from work, and one total freak who kept asking me if I'd ever been in prison. I told him unequivocally, "Not as far as you know.")

Anyway, the seminar was just four weeks away, and there was one session that I still didn't have an outline for. It was called "Correcting Photos from Digital Cameras" (which is dramatically better than my original working title for the class, "Die, Traditional Camera User, Die!").

I knew what I needed to cover in the session, because for the past 10 years I've trained thousands of traditional photographers on how to use Photoshop. Most of them either have now gone digital or are in the process of going digital, and all these digital photographers generally seem to have the same type of Photoshop questions, which I'm actually thankful for, because now I can give them the answers. If they constantly asked different questions, I'd get stumped from time to time, and then I'd have to resort to Plan B (providing answers that sound good, but are in reality just wild-ass guesses).

So I knew what I had to cover, but I wanted to do some research first, to see if other people in the industry were addressing these questions the same way I was, or did they have a different take on them, different techniques or ideas? So I went out and bought every single book I could find about digital photography and Photoshop. I spent nearly $1.2 million. Okay, it wasn't quite that much, but let's just say for the next few months I would have to cut out some luxuries such as running water, trash collection, heat, etc.

I started reading through all these books, and the first thing I thought I'd look up was how they dealt with digital noise (high ISO noise, Blue channel noise, color aliasing, etc.), but as I went through them, I was amazed to find out that not one single book addressed it. Not a one. Honestly, I was shocked. I get asked this question many times at every single seminar, yet not one of these books even mentioned it. So then I started looking for how they work with 16-bit photos. Nothing. Well, one book mentioned it, but they basically said "it's not for you—it's for high-end pros with $15,000 cameras." I just couldn't believe it—I was stunned. So I kept up my search for more topics I'd been asked about again and again, with the same results.

Well, I went ahead with my New York session as planned, and by all accounts it was a big hit. I had photographer after photographer coming up to tell me, "Thank you so much—those are exactly the things I was hoping to learn." That's when I realized that there's a book missing—a book for people who already know how to shoot—they even know what they want to do in Photoshop, they just need somebody to show them how to do it. Somebody to show them how to deal with the special challenges (and amazing opportunities) of using digital photos with Photoshop. I was so excited, because I knew in my heart I could write that book.



So Now I Had Intentions

The day after the seminar I flew home and immediately called my editor at New Riders and I said, "I know what I want my next book to be—a Photoshop book for digital photographers." There was a long uncomfortable pause, and then he politely said, "Really, a digital photography book, huh?" It was clear he wasn't nearly as excited about this concept as I was (and that's being kind). He finally said, "Ya know, there are already plenty of digital photography books out there," and I agreed with him, because I just about went broke buying them all. So now I had to convince my editor that not only was this a good idea, but that it was such a good idea that he should put our other book projects on hold so I could write this book, of which there are (as he put it), "already plenty of digital photography books out there."

Here's what I told my editor what would be different about my digital photography book:

(1) It's not a digital photography book; it's a Photoshop book. There'd be no discussion of film (gasp!), f-stops, lenses, or how to frame a photo. If they don't already know how to shoot, this book just won't be for them. (Note: Editors hate it when you start listing the people the book won't be appropriate for. They want to hear, "It's perfect for everybody! From grandma right up to White House press photographers," but sadly, this book just isn't.)

(2) I would skip the "Here's What a Digital Camera Is" section and the "Here's Which Printer to Buy" section, because they were in all those other books that I bought. Instead, I'd start the book at the moment the photo comes into Photoshop from the camera.

(3) It would work the way digital photographers really work—in the order they work—starting with sorting and categorizing photos from the shoot, dealing with common digital photography problems, color correcting the photos, selecting areas to work on, retouching critical areas, adding photographic special effects, sharpening their photos, and then preparing the photo to be output to a print.

(4) It wouldn't be another Photoshop book that focuses on explaining every aspect of every dialog. No sirree—instead, this book would do something different—it would show them how to do it! This is what makes it different. It would show photographers step-by-step how to do all those things they keep asking at my seminars, sending me email about, and posting questions about in our forums—it would "show them how to do it!"

For example, I told my editor that about every Photoshop book out there includes info on the Unsharp Mask filter. They all talk about what the Amount, Radius, and Threshold sliders do, and how those settings affect the pixels. They all do that. But you know what they generally don't do? They don't give you any actual settings to use! Usually, not even a starting point. Some provide "numerical ranges to work within," but basically they explain how the filter works, and then leave it up to you to develop your own settings. I told him I wouldn't do that. I would flat-out give them some great Unsharp Mask filter settings—the same settings used by many professionals, even though I know some highfalutin' Photoshop expert might take issue with them. I would come out and say, "Hey, use this setting when sharpening people. Use this setting to correct slightly out-of-focus photos. Use this setting on landscapes, etc." I give students in my live seminars these settings, why shouldn't I share them in my book? He agreed. I also told him that sharpening is much more than just using the Unsharp Mask filter, and it's much more important to photographers than the three or four pages every other book dedicates to it. I wanted to do an entire chapter showing all the different sharpening techniques, step-by-step, giving different solutions for different sharpening challenges.

He was starting to come on board with the idea. What he didn't want was the same thing I didn't want—another digital photography book that rehashes what every other digital photography and Photoshop book has already done. Well, he went with the idea, and thanks to him, you're holding the fourth Elements version of the book that I am so genuinely excited to be able to bring you. But the way the book was developed beyond that took it further than I had planned.



How the Book was Developed

When my Editor gave me the final approval (it was more like, "Okay, but this better be good or we'll both be greeting people by saying, 'Would you like to try one of our Extra Value Meals today?'"), I sat down with two of the industry's top digital photographers—commercial product photographer Jim DiVitale and fashion photographer Kevin Ames—to get their input on the book. These two guys are amazing—they both split their time between shooting for some of the world's largest corporations, and teaching other professional digital photographers how to pull off Photoshop miracles at events such as Photoshop World, PPA/PEI's Digital Conference, and a host of other events around the world. We spent hours hammering out which techniques would have to be included in the book, and I can't tell you how helpful and insightful their input was, and this book is far better than it would have been thanks to their contributions.



New and Improved (with the Same Great Taste!)

When we first released The Photoshop Book for Digital Photographers, it became a huge hit overnight, and became not only the best-selling Photoshop book, not only the best-sellling digital photography book, but one of the top selling of all computer books on Amazon.com, and it's ranked as high as No. 12 of ALL books on Amazon.com. Pretty freaky!

In short—the concept worked, and that's why I knew I had to do a special version of the book for Photoshop Elements users because Elements was designed from the beginning as a tool for digital photography. Best of all, I learned a lot from writing that original book, and I've learned a lot of new techniques since I wrote it; and you're getting the benefit of both in this fourth version of the book created just for Elements users.



This Version has a Secret Weapon

Although Elements does offer some cool digital photography features that Photoshop CS2 doesn't even offer, obviously there are plenty of features that Photoshop CS2 has that Photoshop Elements 5 still doesn't have (things like layer masking, Channel Mixer, etc.). But here's the cool part: the single thing that I'm most proud of in this Elements book is that I've been able to figure out workarounds, cheats, and some fairly ingenious ways to replicate some of those Photoshop features from right within Elements. In some cases, it may take a few more steps to get there than it does in Photoshop CS2, but son-of-a-gun, the result looks pretty darn close, and you'll be the only one who'll know the effect was created in Elements, not in Photoshop CS2. This will test how good you are at keeping secrets.



So What's Not in This Book?

There are some things I intentionally didn't put in this book. Like punctuation marks (kidding). No, seriously, I tried not to put things in this book that are already in every other Photoshop Elements book out there. For example, I don't have a chapter on the Layers palette, or a chapter on the painting tools, or a chapter showing how each Elements filter looks when it's applied to the same photograph. However, this Elements 5 version of the book does contain something no previous version has included (besides covering all the most important new features of Elements 5, of course), and that is a special chapter on how to set up Elements' color management and printing so when you print, your prints match what you saw onscreen.



Is This Book For You?

I can't tell you that for sure, so let's take a simple yet amazingly accurate test that will determine without a doubt if this book is for you.

Please answer the following questions:

(1) Do you now, or will you soon have a digital camera?

(2) Do you now, or will you soon have Photoshop Elements?

(3) Do you now, or will you soon have about 40 bucks (the retail price of this book)?

Scoring: If you answered "Yes" to question 3, then yes, this book is for you. If you answered yes to questions 1 or 2, that certainly is a good indicator, too.



Is This Book for Windows Users, Mac Users, or Both?

It's really just for Windows users, because at this point in time, the Mac version of Elements is stuck back on version 4 and doesn't even have all the features of the version 4 for Windows, let alone version 5. In fact, it has some totally different features. It's a long story, but the reality is, I felt that if I tried to cover two very different versions of the same product in one single book it would be somewhat of a train wreck for everybody. So, rather than making a half-butt book that covers both versions (I didn't want to use the word "butt" by the way), I made a kick-butt book for the Windows version, which makes up the vast, vast majority of all Elements users (in fact, I believe there are only six to eight Mac users of Elements, but apparently they're a very vocal group. I totally respect that. In fact, I dig it. But I can't totally trash this book because of it, so this book is really designed for Windows users of Elements 5. Hey, I'm glad you heard it from me first).



How Should You Use This Book?

You can treat this as a "jump-in-anywhere" book because I didn't write it as a "build-on-what-you-learned-in-Chapter-1" type of book. For example, if you just bought this book, and you want to learn how to whiten someone's teeth for a portrait you're retouching, you can just turn to Chapter 7, find that technique, and you'll be able to follow along and do it immediately. That's because I spell everything out. Don't let that throw you if you've been using Elements since version 1; I had to do it because although some of the people who will buy this book are talented traditional photographers, since they're just now "going digital," they may not know anything about Elements. I didn't want to leave them out, or make it hard for them, so I really spell things out like: "Go under the Image menu, under Adjust Color, and choose Levels" rather than just writing "Open Levels." However, I did put the chapters in an order that follows a typical correction, editing, and retouching process; so you might find it useful to start with Chapter 1 and move your way through the book in sequence.

The important thing is that wherever you start, have fun with it, and even more importantly, tell your friends about it so I can recoup the millions I spent on all those digital photography books. Also, although the official name of the software is Adobe Photoshop Elements 5.0, just to keep things short and simple I usually refer to it as just "Elements 5" in the book.



Wait, One More Thing! You Can Download the Photos Used in the Book!

That's right—you can follow right along using downloadable versions of my own photography that's used here in the book, but when I couldn't come up with the ideal shot to illustrate a technique, I was lucky enough to be able to call upon the stock photography community over at iStockphoto.com. So, nearly all of the photos used in this book are available for you to download from the book's companion website at www.scottkelbybooks.com/elements5. Of course, the whole idea is that you'd use these techniques on your own photos, but if you want to practice on these, I won't tell anybody. Okay, now turn the page and get to work!




Organized Chaos:
Managing Photos Using the Organizer

Photographer: Scott Kelby
Exposure: 5 sec
Focal Length: 35mm
Aperture Value: ƒ/11
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"Organized Chaos" is the perfect name for this chapter because not only is it a song title (by the band Benediction), it's also apparently a marketing directive put forth by a super-secret department at Adobe who, from what I gather, is charged with giving features and functions within Elements multiple names. Now, I must point out that this department is not as active in Elements 5, as they were back in Elements 4. Back then, they actually had two different names for what is now just called the Organizer. That's right, Elements 4 had buttons named "Photo Browser" and "Photo Organizer," but regardless of which one you clicked on it opened the Organizer. This led to untold hours of fun for new users of the product, and probably some sort of cash bonus for that department at Adobe. However, those lucrative bonuses are pretty much over in Elements 5 because now the Organizer is just called "The Organizer." However, if you're wondering if the hard-working people in that super-secret department are going to have to get part-time jobs to make up for the gap in their income, you only have to look as far as the Elements 5 Organizer's Window menu, where you'll find a menu command for Photo Browser, which tacitly lets you know their Porsche payments will be made on time. Whew! That was a close one.



Importing Your Photos

In Elements 5, Adobe has not only made the process of getting your photos from your digital camera into the Elements Organizer much easier, they also added some automation to make the task faster, so you can get back to shooting right away. Here's how to import your photos and take advantage of this new automation.



Step One

When you attach a memory card reader to your computer (or attach your camera directly through a USB cable), the Photoshop Elements 5 Photo Downloader's standard dialog appears onscreen (shown here). By the way, it will also download photos from your mobile phone. The first thing it does is it searches the card for photos, and then it tells you how many photos it has found, and how much memory (hard disk space) those photos represent.



[image: image]



Step Two

The Import Settings section is where you decide how the photos are imported. You get to choose where (on your hard disk) they'll be saved to, and you can choose to create subfolders with photos sorted by a custom name, today's date, when they were shot, and a host of attributes you can choose from the Create Subfolder(s) pop-up menu (as shown here).



[image: image]



Step Three

If you want to rename the files as they're imported, you can do that in the next field down. You can use the built-in naming conventions, but I recommend choosing Custom Name from the pop-up menu, so you can enter a name that makes sense to you. You can choose to have the date the photo was shot before your custom name, but that's up to you. If you choose Custom Name, it reveals a text field under the Rename Files pop-up menu where you can simply type in the name that you want (you get a preview of how your new name will look). By the way, it automatically appends a three-digit number starting with 001 after your photo to keep each photo from having the exact same name.
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Step Four

The last option in this dialog is the Delete Options. Basically, it's this: do you want the photos deleted off your memory card after they're imported, or do you want to leave the originals on the card? What's the right choice? There is no right choice—it's up to you. If you have only one memory card, and that card is full and you want to keep shooting, well...the decision is pretty much made for you. You'll need to delete the photos so you can keep shooting. If you've got other back-up cards, you might want to leave the originals on the card until you can make a secure backup of your photos, then erase the card later. Again, the choice is up to you. Now, about that "Automatic Download" button....
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Step Five

The Automatic Download feature is designed to let you skip this whole Photo Downloader dialog, and when you plug in a memory card reader, or camera, it just goes and downloads your photos using your default preferences, with no input from you (well, except it asks if you want to erase the original photos on the card or not). Now, where are these default preferences set? (I knew you were going to ask that.) They're set in the Organizer's Preferences. To get to these, you go under the Organizer's Edit menu, under Preferences, and choose Camera or Card Reader. This brings up the Preferences dialog you see here.
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Step Six

In this Preferences dialog is where you decide what happens when you turn on the Automatic Download checkbox in the Photo Downloader. You get to choose a default location to save all your photos (like your My Pictures folder), and whether you want the Photo Downloader to automatically fix any photos that it detects have red eye. You can also choose to have it automatically suggest photo stacks (it groups photos it thinks belong together). You can have it ignore the Photo Downloader window (just turn off the Auto Launch Adobe Photo Downloader on Device Connect checkbox), and you can have settings for specific cameras or card readers (in case you want separate settings for your mobile phone, or a particular camera). At the bottom, you've got some other options (when to begin the downloading, if you're going to have subfolders, and your delete options). Click OK when the preferences are set the way you want them.
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Step Seven

Okay, back to the Photo Downloader. Now, at this point, all the photos on the card will be imported, but if you want to import just a few selected photos, then you'll need to click on the Advanced Dialog button at the bottom-left corner of the dialog (as shown here). That brings up a dialog that displays thumbnails of all the photos on the card. By default, every photo has a checkbox turned on below it, indicating that every photo will be imported. If you just want some of these photos imported, then you'll need to click the UnCheck All button at the bottom left of your thumbnails. This turns off all the photos' checkboxes, which enables you to then go and turn on the checkbox below only the photos you actually want imported.
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Step Eight

When you look at the right side of the advanced Photo Downloader dialog, you'll see some familiar Save Options (the subfolder choice, renaming files), and in the Advanced Options section, you'll see some of the choices from the Preferences dialog, including the ability to automatically fix red eyes, suggest photo stacks, and delete options. Another nice feature is the ability to embed metadata (like your name and your copyright info) directly into the digital file, just like your camera embeds information into your digital camera images. So, just type in your name and your copyright info, and these are embedded into each photo automatically as they're imported. This is a good thing. When you click Get Photos, your photos are imported (well, at least the photos with a checkmark under them). If you want to ignore these advanced features and just use the Standard dialog, click on the Standard Dialog button.
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Backing Up Your Photos (on Disc or Online)

If you're concerned about having your hard disk crash one day, and losing your entire catalog of photos—you should be. It happens every single day. It's a harsh fact of computer life, and it's not really will your hard drive crash. It's a matter of when. One way to protect your irreplaceable photos is to either back your entire catalog up to disc and/or use an online backup, so your photos are protected in an off-site location. So even if your hard drive dies or your computer is lost, stolen, damaged in a fire, flood, or hurricane, you can retrieve your images.



Step One

To back up your catalog to disc (I recommend backing up to DVD rather than CD if you have a lot of photos [and a DVD writer, of course]), you simply go under the Organizer's File menu and choose Backup Catalog (as shown here).
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Step Two

This brings up a dialog where you decide whether to do a Full Backup (you choose this the first time you back up your catalog), or an Incremental Backup (which is what you'll choose after your first backup, as it only backs up the files that have changed since your last backup, which is a big timesaver). In this case, since this is your first time, choose Full Backup (as shown here), then click the Next button.
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Step Three

When you click Next, the Destination Settings screen appears, which is basically where you tell Elements to back up your stuff to. If it's a DVD or CD, just insert a blank DVD or CD into your DVD/CD drive and choose that drive from the list. Give your disc a name and click the Done button, and it does its thing. Now, that's the standard ol' backup, which is very necessary but doesn't help a lick if the place where you store your backup disc is damaged by fire, storm, flood, hurricane, tornado, a plague of locusts, etc., and that's why you might want to consider the second option—backing up to an offsite location. Luckily, Elements has a direct link to Iron Mountain, a company that offers secure offsite storage of your images for a fee. This works a bit differently, because instead of choosing Backup Catalog, you click on the Order Online button at the top of the Organizer (the one that looks like a globe with a postcard in front of it), and choose Online Backup from its pop-up menu.
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Step Four

When you choose Online Backup, you're taken directly to Iron Mountain's Adobe Photoshop Services website (shown here), where they offer you a free 30-day trial (at least they did when I wrote this book). The process is pretty simple: once you register, you download their free Connected DataProtector software, it finds all your digital photos (or you point it to a folder of your images), it uploads them to Iron Mountain for you, and keeps them in your personal storage account. It's all automated from that point on—every day it looks for new photos on your drive, and if it finds them, it backs them up online automatically. Your images are easily retrieved if something unfortunate should happen.



[image: image]



Creating a Contact Sheet for Your CD

All right, your CD of "digital negatives" is burned and it's time to get to work, but before you go any further, you can save yourself a lot of time and frustration down the road if you create a CD-jewel-case-sized contact sheet now. That way, when you pick up the CD, you'll see exactly what's on the disc before you even insert it into your computer. Luckily, if you have Adobe Acrobat, the process of creating this contact sheet is automated, but if not, you'll need to make a few decisions on how you want your contact sheet to look by "eyeing" it.



Step One

First, open the photos you want to appear on your contact sheet in the Elements Editor, then go under the File menu and choose Print Multiple Photos (or press the keyboard shortcut Control-Alt-P). (Note: If you're already working in the Organizer, you can create a contact sheet from the currently open collection by going under the Organizer's File menu and choosing Print.)
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Step Two

Choosing Print Multiple Photos first brings up the Elements Organizer, and immediately after, the Print Photos dialog will appear. Along the left side of the dialog, you will see your image thumbnails. (Note: If you open the dialog from the Editor, Elements will place them in the reverse of the order in which you opened them. So, make sure you open them in reverse order, or open the dialog from the Organizer.) Then, there are three categories on the right side of the dialog. Under the Select Type of Print category, choose Contact Sheet from the pop-up menu.
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Step Three

Now that you've told Elements that you want to print a contact sheet (and the preview window shows how your selected photos would look as a contact sheet on a letter-sized page, which is its default size), your next step should be to specify the size you need your contact sheet to be (in this case, one that will fit in the front of a CD jewel case). To do that, start by choosing Adobe PDF in the Select Printer pop-up menu. Then, click on the blue-and-white icon that appears to the immediate right of the Select Printer pop-up menu at the top right of the dialog. Note: If you don't have Adobe Acrobat, this option will not appear, in which case, skip to the Alternate Step that starts after Step Seven.
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Step Four

This brings up a dialog with options for your printer (since we're printing to an Adobe PDF driver rather than printing the file out to a regular printer, you'll see the options for a PDF). Since Adobe didn't include a standard size for CD jewel cases, you're going to create one by clicking the Add button to the right of the Adobe PDF Page Size pop-up menu, which brings up the dialog shown here.
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Step Five

First, give your new paper size a name (something like "CD Jewel Case") in the Paper Names field. Then in the Paper Size section, enter 4.5 for Width and 4.5 for Height, click the Inch radio button in the Unit section (if it's not already selected), and then click the Add/Modify button to save your custom size in the Adobe PDF Page Size pop-up menu's list of presets.
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Step Six

When you click Add/Modify, it returns you to the Adobe PDF Document Properties dialog. Click on the Adobe PDF Page Size pop-up menu, and you'll see that your new custom size (CD Jewel Case) now appears in the list. Click on it to select it as your contact sheet size.
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Step Seven

When you click OK, the contact sheet preview will now display how your contact sheet thumbnail photos will appear on your CD jewel case. (Note: The name CD Jewel Case will appear below the preview.) If you have more than one page's worth of photos open, you'll have more than one page of thumbnails (instead of seeing page 1 of 1, it'll say something like 1 of 2, or 1 of 3, and so on). To see any additional pages, click on the right-facing arrow button below the preview.
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Alternate Step

If you don't have Acrobat, there is a hokey workaround (sorry, but until Adobe adds a CD jewel case option to this dialog, which had been there in previous versions of Elements, we're stuck with a hokey workaround). Simply choose a higher amount in the Columns pop-up menu in section 3. Try 7–8 columns, and then "eye" your contact sheet using the preview in the dialog. You're trying to create a block of thumbnails that will print no larger than 4.5x4.5", so you can then cut your sheet to this size after printing. With that set, move on to Step Eight.
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Step Eight

On the right side of the dialog, you can decide if you want to have Elements print the file's name below each thumbnail on your contact sheet. I strongly recommend turning this feature on because one day you may have to go back to this CD looking for a photo. The thumbnail will let you see if the photo you're looking for is on this CD (so you've narrowed your search a bit), but if there's no name below the image, you'll have to manually search through every photo on the CD to locate the exact one you saw on the cover. Believe me, it's one of those things that will keep you from ripping your hair out by the roots, one by one. Now you can click Print and your contact sheet is created in PDF format and opened in Elements. So, just go the File menu, select Print, and print your contact sheet to your printer.
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Step Nine (or So You Think...)

This is more like a tip than a step, but a number of photographers add a second contact sheet to make it even easier to track down the exact image they're looking for. It's based on the premise that in every roll (digital or otherwise) there are usually one or two key shots—two really good "keepers"—that will normally be the ones you'll go searching for. So what they do is make an additional contact sheet that either becomes the front cover of the jewel case (with the regular contact sheet behind it in the case) or vice versa. This additional contact sheet includes a description of the shots, to make finding the right image even easier.
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Step Ten

Here's the final result with a two-photo contact sheet for the cover of the CD jewel case, after a regular contact sheet with multiple images was printed and slid into the CD jewel case behind it. To create this contact sheet, open one or two images in the Editor and create a new document that's 4.5x4.5". Press V to get the Move tool, drag-and-drop your open images onto your new document, and then press Control-T and then Control-0 (zero) to bring up Free Transform. Resize your images on the page, and then press the letter T to switch to the Type tool and enter descriptive text next to your contact sheet thumbnail(s). Now print your new contact sheet.
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Dealing with the Welcome Screen

I know, the name "Dealing with the Welcome Screen" makes the Welcome Screen sound like something obtrusive, but really it's not. At least, not at first. In fact, at first it's welcome (like the way I worked that in there?), but after you've seen it a few hundred times, if you're like most folks you'll probably want it to go away. But before you make it go away for good, there are a few things you might want to decide first. And they are...



The First Time

The Welcome Screen that appears when you launch the program is designed to help first-time users figure out what they want. If you're holding this book, my guess is you already know what you want, so click the Edit and Enhance Photos option near the top center of the Welcome Screen, which takes you right into the Elements Editor (which, if you've used previous versions of Elements, you know simply as Photoshop Elements).
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Future Uses

You can use this Welcome Screen to decide what happens when you launch Elements 5 later. For example, by default it wants to show you this Welcome Screen each time you launch Elements. You may want that the first few times, but once the novelty wears off, you'll want to go straight to the Editor. So, you just need to change one thing: At the bottom left-hand corner of the Welcome Screen, where it says "Start Up In" you'll see the words "Welcome Screen." Click on Welcome Screen and choose Editor from the pop-up menu that appears. Now when you start up Elements, you'll get the Editor.
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Start with Sorting

If you'd prefer to skip the Welcome Screen and instead go right into sorting your images rather than editing them, you can go to the built-in Organizer (which used to be the standalone product Photoshop Album) by choosing Organizer from the Start Up In pop-up menu.
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Welcome Back Welcome Screen

Okay, what if you've chosen to start up in the Editor or Organizer, and then at some later date you think you'd like to get that Welcome Screen back again? It's easy—just go under the Window menu (in either the Editor or Organizer) and choose Welcome, and the screen will reappear. However, once you close it, it won't reappear at startup unless you change the Start Up In pop-up menu in the bottom-left corner to Welcome Screen.
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Other Options

One last thing—just to save you some time: If you have the Welcome Screen open, there are two buttons that actually take you to the Editor—they just take you to different parts. Quickly Fix Photos opens the Editor in the Quick Fix mode, and Edit and Enhance Photos just launches regular ol' Elements 5 (the Editor).
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Importing Photos from Your Scanner

Because this is a book for digital photographers, I imagine most of your photos will come from a digital camera (if so, see "Importing Your Photos"), but if you've been a photographer for a while now, you probably have some traditional prints lying around that you'd like to scan in, so here we'll look at importing scanned images into the Organizer.



Step One

To scan images and have them appear in your Organizer, click the Organize button in the Elements Editor's task bar (above the Options Bar) to launch the Organizer. Then in the Organizer's task bar (above the Timeline), click on the Get Photos button (it looks like a digital camera icon with photos behind it) and choose From Scanner. By the way, once the Organizer is open, you can also use the shortcut Control-U to import photos from your scanner.
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Step Two

Once the Get Photos from Scanner dialog is open, choose your scanner from the Scanner pop-up menu. Choose a high Quality setting (I generally choose the highest quality unless the photo is for an email to my insurance company for a claim—then I'm not as concerned). Then click OK to bring in the scanned photo. See, pretty straightforward stuff.
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Automating the Importing of Photos by Using Watched Folders

This feature in Elements is a huge timesaver because it lets you choose a folder that is "watched" by the Organizer. When you drag photos into this folder, they will automatically be added to your Organizer. Here's how to set it up:



Step One

Go under the Organizer's File menu and choose Watch Folders.
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Step Two

When the Watch Folders dialog appears, make sure the Watch Folders and Their Sub-Folders for New Files checkbox is turned on. In the Folders to Watch section, click the Add button, and then in the resulting dialog, navigate to any folders you want the Organizer to "watch" for the addition of new photos. Select the folder you want to watch, and then click OK. Continue to click the Add button and select more folders to watch. When you've selected all your folders, they will appear in the Folders to Watch section of the Watch Folders dialog, where you have the choice of having the Organizer alert you when new photos are found in the watched folders (meaning you can choose to add them) or you can have them added automatically, which is what this feature is really all about. But if you're fussy about what gets added when (i.e., you're a control freak), at least you get an option.
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Changing the Size of Your Photo Thumbnails

Thumbnails of your photos are displayed in the Organizer's Photo Browser, and luckily you have great control over what size they're displayed at.



Step One

The size of your thumbnails is controlled by a slider at the bottom-right corner of the Photo Browser window. Drag the slider to the right to make them bigger—to the left to make them smaller. To jump to the largest possible view, just click on the Single Photo View icon to the immediate right of the slider. To jump to the smallest size, click on the Small Thumbnail Size icon to the left of the slider. To jump up one size at a time, hold the Control key and press the Plus Sign (+) key. To go down in size, press Control-Minus Sign (-).
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Step Two

Another shortcut to jump to the largest view is to just double-click on your thumbnail. At this large view, you can enter a caption directly below the photo by clicking on the placeholder text (which reads "Click here to add caption") and typing in your caption.



[image: image]



Seeing Full-Screen Previews

How about this for a view? Elements lets you see a full-screen preview of a selected thumbnail—all without leaving the Organizer. It's like an onscreen slide show of your thumbnails. Here's how it works:



Step One

To see a full-screen preview of your currently selected photo(s), click on the Full Screen View icon (it looks like a tiny monitor) in the far right-hand corner of the Photo Browser window (or just press F11).
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Step Two

This brings up the Full Screen View Options dialog with a number of presentation choices that you normally get for a slide show. Basically, that's what you'll use this Full Screen View feature for, but if you only select one photo, it shows just that one photo at full screen. So when this dialog appears, click OK and your photo will be displayed full screen. If you want to return to the Photo Browser, press the Escape key on your keyboard. By the way, once your photo(s) appears full screen, there's a floating palette at the top of the screen where you can control your viewing options—click the Play button to start it and click the Pause button to stop it. In case you want to create an actual slide show of those photos you're viewing, you can click on the Action Menu button in the middle of the palette and choose Create Slide Show from the pop-up menu.
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Sorting Photos by Date

When photos are imported into the Organizer, the Organizer automatically sorts them by date. How does it know on which dates the photos were taken? The time and date are embedded into the photo by your digital camera at the moment the photo was taken (this info is called EXIF data). The Organizer reads this info and then sorts your photos automatically by date, but finding the photos by date takes a little doing on your part.



Step One

By default, the newest photos are displayed first, so basically, the last photo you shot will be the first photo in the Organizer. Also, by default, the exact date each photograph was taken is shown directly below each photo's thumbnail. (Note: If you don't want this extra detail about each photo to be visible, just deselect the Details checkbox at the bottom-left side of the Photo Browser window.)
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Step Two

If you'd prefer to see your photos in reverse order (the oldest photos up top), then choose Date (Oldest First) from the pop-up menu in the bottom-left corner of the Photo Browser window. There you have it!
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Adding Scanned Photos? Enter the Right Time and Date

I know, I know—this is a book for "digital" photographers, but you know, and I know, that you've got a scanner. At some point you're going to scan some photos (then they'll become "digital images"), and then you'll want these images to be automatically organized in your catalog. All the scanned photos will have their "creation" date as the day you scanned them, unless you add your own date. This way, you can set the approximate date to when they were shot so they'll appear in your catalog when they were taken, rather than when they were imported.



Step One

First, get the photos from your scanner (see the "Importing Photos from Your Scanner" tutorial earlier in this chapter). Select all the photos you want to set the date for by Control-clicking each image (or Shift-clicking the first and last images if they are contiguous) in the Photo Browser window. Then, go under the Organizer's Edit menu and choose Adjust Date and Time (or press Control-J).
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Step Two

This brings up a dialog asking how you want to handle the date and time for these photos. For this example, select Change to a Specified Date and Time and click OK.
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Step Three

This brings up the Set Date and Time dialog, where you can use the pop-up menus to set your selected photos' date and time. Now these photos will appear sorted by the date you entered, rather than the date you imported them.
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Finding Photos Fast by Their Month and Year

The method that the Organizer uses to help you find the photos you're looking for is month and year. It figures you might not know exactly when you took a group of photos, but let's say, for example, you're trying to find the photos from your last vacation. If you know you went sometime last summer—even if you can't remember whether it was May, June, or July—you can get mighty close mighty fast using the Month/Year Timeline. Here's how it works:



Step One

We're going to assume you're trying to find vacation photos (as outlined above). You see those bars along the Timeline that look like the little bar charts from Microsoft Excel? Well, the higher the bar, the more photos that appear in that month. So click on any month in 2005 and only the photos taken in that month will appear in the Photo Browser window. As you slide your cursor to the left (or right), you'll see each month's name appear. When you get to July, only photos taken in July 2005 will appear. Take a quick look and see if any of those photos are your vacation photos. If they're not in July, scroll back on the Timeline to May, and only those photos will be visible.
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Tagging Your Photos (Tags Are Keywords)

Although finding your photos by month and year is fairly handy, the real power of the Organizer appears when you assign tags (keywords) to your photos. This simple step makes finding the exact photos you want very fast and very easy. The first step is to decide whether you can use the pre-made tags that Adobe puts there for you or whether you need to create your own. In this situation, you're going to create your own custom tags.



Step One

Start by clicking on the Tags button on the right side of the Organizer. Adobe's default set of tags will appear in a vertical list. (By the way, if you don't see the Tags and Collections buttons on the right side of the Organizer, click on the words "Organize Bin" at the bottom-right corner of the Organizer window.)
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Step Two

You'll start by creating your own custom category (in this case, we're going to create a category of all travel shots taken for a magazine client). Click on the New pop-up menu that appears just below the Tags button itself and choose New Category. This brings up the Create Category dialog. Type in "Travel Shots." Now choose an icon from the Category Icon list and then click OK. (The icon choices are all pretty lame, but at least we can use the globe icon.)
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Step Three

To create your own custom tag, click on the New pop-up menu again and choose New Tag. This brings up the Create Tag dialog. Choose Travel Shots from the Category pop-up menu (if it's not already chosen), then in the Name field, type in a name for your new tag (here I entered "Disney's Epcot Center"). If you want to add additional notes about the photo shoot, you can add them in the Note field, or you can choose a photo as an icon by clicking the Edit Icon button. Now click OK to create your tag.
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Step Four

Now you'll assign this tag to all the photos from this shoot. In the Photo Browser window, scroll to the photos from that shoot. We'll start by tagging just one photo, so click on your new tag that appears at the bottom of your Tags list and drag-and-drop that tag onto any one of the photos. That photo is now "tagged." If you have the photo's Details visible (if not, turn on the Details checkbox at the bottom-left corner of the Photo Browser window), you'll see a small tag icon appear below the photo's thumbnail (in this case, the globe icon).



SCOTT KELBY

[image: image]



Step Five

So at this point, we've only tagged one photo from this shoot. Drag-and-drop that same tag onto five more photos from the shoot so a total of six photos are tagged. Now, in the list of Tags on the right side of the Organizer, click in the small box in the column to the left of your new tag (a tiny binoculars icon will appear in that box), and instantly, only the photos with that tag will appear in the Photo Browser window. To see all your photos again, click on the Back to All Photos button that appears at the top left of the Photo Browser window.
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Tagging Multiple Photos

Okay, you've learned how to create your own custom category, then a custom tag so you can sort one shoot from the other, but you're dragging-and-dropping that tag onto one photo at a time (which takes too much time for an entire shoot). There are faster ways than this one-tag-at-a-time method. For example...



Step One

To tag all the photos from your shoot at the same time, try this: First, click on any untagged photo from the shoot. Then hold the Control key and click on other photos from that particular shoot. As you click on them, they'll become selected (you'll see a thin blue box around each selected photo). Or, if all the photos are contiguous, click on the first image in the series, press-and-hold the Shift key, and then click on the last image in the series to select them all.



SCOTT KELBY

[image: image]



Step Two

Now drag-and-drop your newly-created tag onto any one of those selected photos, and all of the selected photos will have that tag. If you want to see just the photos from that shoot, you can click in the box to the left of that tag and only photos with that tag will appear. By the way, if you decide you want to remove a tag from a photo, just Right-click on the photo and from the contextual menu that appears, choose Remove Tag. If you have more than one tag applied, you can choose which tag you want removed.
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Assigning Multiple Tags to One Photo

Okay, what if you want to assign a tag to a photo, but you also want to assign other tags (perhaps a "Client Work" tag and a "Make Prints" tag), as well? Here's how:



Step One

To assign multiple tags at once, first, of course, you have to create the tags you need, so go ahead and create two new tags by clicking on the New pop-up menu just below the Tags button— naming one "Client Work" and another "Make Prints." Now you have three tags you can assign. To assign all three tags at once, just hold the Control key, then in the Tags list, click on each tag you want to assign (Disney's Epcot Center, Client Work, and Make Prints).
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Step Two

Now click-and-drag those selected tags, and as you drag, you'll see you're dragging three tag icons as one group. Drop them onto a photo, and all three tags will be applied at once. If you want to apply the tags to more than one photo at a time, first hold the Control key and click on all the photos you want to have all three tags. Then, go to the Tags list, hold the Control key again, and click on all the tags you want to apply. Drag those tags onto any one of the selected photos, and all the tags will be applied at once. Cool.
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Tagging Images of People (Face Tagging)

You're either going to think this is the coolest, most advanced technology in all of Elements 5, or you're going to think it's creepy and very Big Brother-ish (from the book by George Orwell, not the TV show). Either way, it's here to help you tag people easier because the Organizer can now automatically find photos of people for you—as it has some sort of weird science, facial-recognition software built in (that at one point was developed for the CIA, which is all the more reason it belongs in Elements).



Step One

Okay, let's say you went on a family vacation, and you want to quickly find all the photos that have your daughter in them, without having to search through the hundreds of images you imported. Well, first go ahead and open the Organizer, because that's where our hunt will take place. Now select the group of photos you want to search through (you can do a Control-A to Select All, click on a collection, or just Control-click on as many images as you want to sort through).
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Step Two

Go under the Find menu, and at the bottom of the menu choose Find Faces for Tagging. This brings up the Face Tagging dialog. Within just a few moments (depending on how many photos you have), it will sort through your selected images and separate out the images that contain a human face.
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Step Three

Once these images appear in the Face Tagging dialog, you can Control-click on the photos of your family, and then drag-and-drop the appropriate tag from the Tags palette onto any one of the selected photos. They'll all be assigned that tag.
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Step Four

If you only want to see faces that haven't already been tagged, ensure the checkbox for Show Already Tagged Faces is off at the top of the Face Tagging dialog. When you're done, click Done to return to the main Organizer window.
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Tip

As cool as this Face Tagging technology is, it doesn't stop there. Let's say you have a photo of a tall building, and you want to find all the similar photos that have a tall building. Just click on one of your building photos, then go under the Find menu and choose By Visual Similarity with Selected Photo(s). It will look for photos that have similar attributes (such as a building, similar colors, or orientation) to what you've already chosen. Pretty CSI Las Vegas, dontchathink?
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Combining (Merging) Tags

It's easy to go "tag crazy," and if that happens (and you've got dozens of different tags applied to your photos), you may want to simplify by merging some of your tags together. For example, if you shot the Olympics, and you have tags for the 100-meter dash, 400-meter dash, 600-meter dash, and a half dozen more dashes, you may want to combine all those separate tags into just one tag. Here's how:



Step One

To combine (merge) multiple tags into just one convenient tag, start by holding the Control key and clicking on all the tags that you want to combine in the Tags list on the right side of the Organizer. Then Right-click on any of your selected tags, and from the contextual menu that appears, choose Merge Tags.
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Step Two

This brings up a dialog that asks you which of the selected tags will be the surviving tag (in other words, which tag will remain after the rest are merged into this one). Choose the tag that will remain from the list of tags, then click OK. The tags will be merged into that one. Every photo that had any one of those selected tags will now have the one combined tag.
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Sharing Your Tags (or Collections) with Others

Let's say you went to the Super Bowl with a group of photographers, and they're using Elements 5, too. If you've created a nice set of tags for identifying images, you can now export these tags and share them with the other photographers from that trip. That way, they can import them and start assigning tags to their Super Bowl photos without having to create tags of their own.



Step One

To export your tags to share with others, start by going to the Tags palette (on the right side of the Organizer), then click on the New pop-up menu and choose Save Tags to File.
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Step Two

When the dialog appears, you can choose to Export All Tags, or better yet, click on the Export Specified Tags radio button, and then you can choose which tags you want to export from the pop-up menu. Choose the tags you want to export, and click OK. A standard Windows Save dialog will appear, so you can choose where you want your file saved. Name your file, click Save, and now you can email your exported tags to a friend.
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Step Three

Once your friends receive your tags, tell them they can import your tags by going to the Tags palette, clicking on the New pop-up menu, and choosing From File. Now they just locate the file on their hard drive and click Open. The new tags will appear in their Tags palette.
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Collections: It's How You Put Photos in Order One by One

Once you've tagged all your photos, you may want to create a collection of just the best photos (the ones you'll show to your clients). You do that by creating a "collection." An advantage of collections is that once photos are in a collection, you can put the photos in the order you want them to appear (you can't do that with tags). This is especially important when you start creating your own slide shows and albums.



Step One

To create a collection, click on the Collections button on the top-right side of the Organizer (it's just to the right of the Tags button when you have the Organize Bin open). You create a new collection by clicking on the New pop-up menu, then choosing New Collection. When the Create Collection dialog appears, enter a name for your collection, and then click OK.
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Step Two

Now that your collection has been created, you can either (a) drag the Collection icon onto the photos you want in your collection, or (b) Control-click photos to select them and then drag-and-drop them onto your Collection icon in the Collections palette. Either way, the photos will be added to your collection. To see just the photos in your collection, click on the box in the column to the left of your collection and tiny binoculars will appear. Now, to put the photos in the order you want, just click on any photo and drag it into position. The Organizer automatically numbers the photos for you in each thumbnail's top-left corner, so it's easy to see what's going on as you drag. To return to all of your images, click the Back to All Photos button in the top-left corner of the Photo Browser window.
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Choosing Your Own Icons for Tags and Collections

By default, a tag or collection uses the first photo you add to that tag or collection as its icon. Unfortunately, these icons are so small that you probably can't tell what the icon represents. That's why you'll probably want to choose your own photo icons instead.



Step One

It's easier to choose icons once you've created a tag or collection, meaning you've tagged a few photos or added some photos to a collection. Once you've done that, click on your tag or collection, then click on the Pencil icon (it's in the bar right under the Tags and Collections buttons). This brings up the Edit Tag (or Collection) dialog. In this dialog, click on the Edit Icon button to launch the dialog you see here.
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Step Two

You'll see the first photo in your collection in the preview window (this is why it's best to edit the icon after you've added tags or collections to the photos). If you don't want to use this first photo, click the arrow buttons under the bottom-right corner of the preview window to scroll through your photos. Once you find the photo you want to use, click on the little cropping border (in the preview window) to isolate part of the photo. This gives you a better close-up photo that's easier to see as an icon. Then click OK in the open dialogs and that cropped image becomes your icon.
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Deleting Tags (or Collections)

If you've created a tag or a collection, and then later decide that you don't want that tag or collection, you can delete it in just three clicks.



Step One

To delete a tag or collection, start by clicking on the tag or collection you want to delete in the Tags or Collections palette on the right side of the Organizer.
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Step Two

Once you've selected the tag or collection you want to delete, just click the Trash icon at the top of the Tags (or Collections) palette (it's found to the immediate right of the New pop-up menu). If you're deleting a tag, when you click on the Trash icon, it brings up a warning dialog letting you know that deleting the tag will remove it from all your photos. If you want to remove that tag, click OK. If you've got a collection selected when you click the Trash icon, it asks if you want to delete the collection. Click OK and it's gone. However, it does not delete these photos from your main catalog—it just deletes that collection.
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Seeing Your Photo's Metadata (EXIF Info)

When you take a photo with a digital camera, a host of information about that photo is embedded into the photo by the camera itself. It contains just about everything, including the make and model of the camera that took the photo, the exact time the photo was taken, what the f-stop setting was, what the focal length of the lens was, and whether or not the flash fired when you took the shot. You can view all this info (called Exchangeable Image File [EXIF] data—also known as metadata) from right within the Organizer. Here's how:



Step One

To view a photo's EXIF data, first click on the photo in the Photo Browser, and then click the Show or Hide Properties button at the bottom-left side of the Photo Browser window to show the Properties palette.
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Step Two

When the Properties palette appears in the bottom-right corner of the Organize Bin, click the Metadata button at the top of the palette (it's the fourth button from the left). This shows an abbreviated version of the photo's EXIF data (basically, the make, model, ISO, exposure, f-stop, focal length of the lens, and the status of the flash). Of course, the camera embeds much more info than this. To see the full EXIF data, under the View section at the bottom of the palette, just select Complete and you'll get more information on this file than you'd probably ever want to know. One thing that isn't displayed in the Brief view that you probably might want to know is the date and time the photo was taken, and to see that you will have to open the Complete view.
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Adding Your Own Info to Photos

Although your digital camera automatically embeds information into your photos, you can also add your own info from right within the Organizer. This includes simple things like a photo caption (that can appear onscreen when you display your photos in a slide show), or you can add notes to your photos for your personal use, either of which can be used to help you search for photos later.



Step One

First, click on the photo in the Photo Browser window you want to add your own info to and click the Show or Hide Properties button at the bottom left of the Organizer, or you can also use the keyboard shortcut by pressing Alt-Enter.
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Step Two

This brings up the Properties palette along the bottom-right corner of the Organizer. At the top of the palette are four buttons for the four different sections of your photo's properties. By default, the General section is selected. In the General section, the first field is for adding captions (I know, that's pretty self-explanatory), and then the photo's file name appears below that. It's the third field down—Notes—where you add your own personal notes about the photo.
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Step Three

If you want to see other info about your photo (for example, which tags have been added to your photos; the date when you imported the photo or when you last printed, emailed, or posted the photo on the Web; or the info embedded into the photo by your digital camera), just click on the various buttons at the top of the palette.
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Finding Photos

Finding a group of photos is fairly easy using the Organizer, especially if you've tagged your images, but finding an individual photo takes a bit of work. It's not hard; it just takes some effort because you essentially have to narrow the amount of photos down to a small group (like the month or day you shot the photos). Then you scroll through the photos in that group until you find the individual photo you want. It sounds complicated, but it's really quite easy. Here are the most popular searching methods:



From the Timeline

The Timeline, which is a horizontal bar across the top of the Photo Browser, shows you all the photos in your catalog. Months and years are represented along the Timeline. The years are visible below the Timeline; the small light blue bars above the Timeline are individual months. If there is no bar visible, there are no photos stored in that month. A short blue bar means just a few photos were taken that month—a tall bar means lots of photos. If you hover your cursor over a blue bar, the month it represents will appear. To see the photos taken in that month, click on the bar and only those photos will be displayed in the Photo Browser window. Once you've clicked on a month, you can click-and-drag the locator bar to the right or left to display different months.
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Using Tags

If there's a particular shot you're looking for, and you've tagged all your shots with a particular tag, then just click on the Tags button and click on the empty box in the column to the left of that tag. Now only shots with that tag will appear in the Photo Browser window.
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By Date Ranges

Let's say you're looking to find a particular photo you shot on vacation. If you can remember approximately when you went on vacation, you can display photos taken within a certain date range (for example, all the photos taken between June 1 and June 30, 2005). Here's how: Go under the Organizer's Find menu and choose Set Date Range. This brings up a dialog where you can enter start and end dates. Click OK and only photos taken within that time frame will be visible. Scroll through those images to see if you can find your photo.
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By Caption or Note

If you've added personal notes within tags or you've added captions to individual photos, you can search those fields to help you narrow your search. Just go under the Organizer's Find menu and choose By Caption or Note. Then in the resulting dialog, enter the word that you think may appear in the photo's caption or note, and click OK. Only photos that have that word in a caption or note will appear in the Photo Browser window.
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By History

The Organizer keeps track of when you imported each photo and when you last shared it (via email, print, webpage, etc.); so if you can remember any of those dates, you're in luck. Just go under the Organizer's Find menu, under By History, and choose which attribute you want to search under in the submenu. A dialog with a list of names and dates will appear. Click on a date and name, click OK, and only photos that fit that criterion will appear in the Photo Browser window.
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Finding Photos Using the Date View

Okay, I have to admit, this particular feature is probably going to be your least-used Organizer feature because it seems so...I dunno...cheesy (for lack of a better word). When you use it, you see a huge calendar, and if photos were created on a particular day in the currently visible month, you'll see a small thumbnail of one of those images on that date. Personally, when I see this view, I feel like I've just left a professional-looking application and entered a "consumer" application, so I avoid it like the plague, but just in case you dig it (hey, it's possible), here's how it works:



Step One

To enter the Date View in the Organizer, click the Date View button at the bottom of the Photo Browser window.
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Step Two

This brings up the Date View calendar window with the Month view showing by default (if you're not in Month view, click the Month button along the bottom center of the window). If you see a photo on a date, it means there are photos that were taken (or you scanned or imported) on that day. To see a photo, click on it within the calendar and a larger version will appear at the top right of the Date View window. To see the rest of the photos on this day, click the Next Item on Selected Day button found directly under this preview window. Each time you click this button, the window displays a preview of the next photo taken on that day.



SCOTT KELBY

[image: image]



Step Three

If you find the photo you're looking for (I'm assuming that if you're searching around in the Date View, you're looking for a particular photo) and you want to edit that photo, Right-click on the photo's preview and choose Go to Full Edit (or just press Control-I). The Elements Editor will launch with your photo open and ready to edit.
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Step Four

Return to the Organizer and click the Date View button again. While we're here, I want to show you a couple of the other features. Although the Month view is shown by default, there are buttons at the bottom center of the Date View window for viewing the entire year (where days that have photos appear as solid-color blocks) or an individual day (where all the photos from that day appear in a slide-show-like window as shown here).
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Step Five

While in the Date View, you can add a Daily Note, which is a note that doesn't apply to the current photo—it applies to every photo taken on that calendar day. If you change to the Day view (by clicking the Day button at the bottom of the Date View window), fields for adding a Caption and a Daily Note to the currently displayed photo will appear along the right side of the window. Now when you're in Day view, you can not only see your caption for your photo, but you can also see the Daily Note for each photo taken on that calendar day.
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Seeing an Instant Slide Show

If you want to see a quick slide show of a collection or currently selected photos in the Organizer, it's pretty much just a two-click process. Later in this book, I show you how to create rich, fully featured slide shows using an entirely different feature of Elements 5, but for now we'll just look at how to create a quickie slide show with minimum time and effort.



Step One

First, open the Organizer. Now press-and-hold the Control key and click on each photo you want to appear in your slide show (if the photos are contiguous, you can click on the first photo, hold the Shift key, click on the last photo, and all the photos in between will be selected). Once the photos you want are selected, click on the Full Screen View icon (it looks like a little monitor) at the bottom right of the Photo Browser window.
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Step Two

This brings up the Full Screen View Options dialog, which contains presentation options for your slide show. You can choose music that will play during your slide show from the Background Music pop-up menu. You can also choose how long each photo will appear onscreen. By default, it assumes you want any captions included, but you can turn that off by clicking the Include Captions checkbox, and you can also have your slide show loop when it reaches the end by turning on the Repeat Slide Show checkbox. Now click OK to begin your slide show.
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Step Three

Once you click OK, you'll enter Full Screen View mode, where you'll see a floating slide show control palette on the top-left side of your screen. Your slide show won't actually start advancing until you click the Play button (or press the Spacebar, or the shortcut F5). To stop your slide show from advancing (to pause it), click the Pause button in the control palette (the Play button toggles to the Pause button while the slides are in motion), and then to resume the slide show, just click Play/Pause one more time.
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Step Four

Besides the standard Previous, Play/Pause, Next, and Exit buttons that appear in the control palette, you'll also see other controls on the right. These extra controls are for comparing still images and are not for use during your slide show. To hide these other controls, click on the tiny left-facing arrow on the far-right side of the control palette and it will collapse down to just display the slide show controls.
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Step Five

To quit your slide show and return to the Photo Browser, press the Escape key on your keyboard or click the Exit (X) button on the control palette.
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Comparing Photos

Let's say you've just shot some city life photos, and now you're looking at 14 shots of people and city streets. The Organizer has a great feature that lets you compare two images onscreen (either side by side or one above the other) to help you narrow down your choice to the best possible photo.



Step One

First, open the Organizer. To compare (or review) photos side by side, hold the Control key and click on all the photos you want to compare. Then click the Full Screen View icon at the bottom right of the Photo Browser window (or just press the F11 key on your keyboard). This brings up the Full Screen View Options dialog, which presents options for a slide show. You can ignore those slide show options and just click OK to enter Full Screen View mode, which can be used to compare images.
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Step Two

The photo you selected first will appear in Full Screen View mode, and you'll see a floating control palette at the top-left side of your screen. Click on the Side by Side View button (it looks like two boxes), which puts the first and second photos you selected side by side onscreen. The first photo (on the left) has the number 1 in its upper left-hand corner, and the second photo (the one being compared) is noted as number 2 when clicked on.



SCOTT KELBY

[image: image]



Step Three

Now visually compare these two photos. You'll want the one that looks best to remain onscreen so you can compare other selected photos against it, right? To do that, click on the "bad" photo, and a blue highlight will appear around that photo, indicating that this is the one that will change. In this example, I thought the second photo looked better, so I clicked on photo number 1 (the one on the left).
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Step Four

Now go to the control palette, click on the Next Photo button, and the first photo will be replaced with your next photo in that series. Again, review which of these two looks the best, then click on the photo that looks worst (that way, you can replace it with another photo you want to compare). Click the Next Photo button to compare the next photo (and so on). To back up and review a previous photo, click the Previous Photo button in the control palette.
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Step Five

Besides this side-by-side mode, there's also an option that lets you see your photos stacked one on top of the other (which you might like for comparing photos in landscape orientation). To change to that mode, click on the down-facing arrow to the immediate right of the Side by Side View button, and from the pop-up menu that appears, choose Above and Below. Cycle through the images as you did before—just repeat Steps Three and Four until you find the photo you like best. When you're finished, press the Escape key on your keyboard or click the Exit (X) button in the control palette.
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Comparing Photos by Zooming and Panning

This isn't exactly an Organizer technique, but there's also a way to compare photos in the Elements Editor. This is a cool feature that Elements borrows from Photoshop—the ability to view multiple images at once (for comparison purposes)—but more importantly, to be able to view each one at the same magnification (even when changing zoom magnifications). You can scroll around (pan) to inspect images and have all the images pan at the same location and rate. This is one you need to try to really appreciate.



Step One

Open the multiple photos you want to compare in the Editor. (In this instance, we'll compare four photos, so open four photos, which will appear in the Photo Bin at the bottom of the Editor window. The power of this feature will be more apparent if you open four similar images, like four portraits of the same person at one sitting, etc.)
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Step Two

Go under the Window menu, under Images, and choose Tile. This will put all your photos in their own separate windows, and then it will tile these four open windows across your screen so you can see all four photos at once.
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Step Three

Now that your photos are tiled, return to the Window menu, under Images, and choose Match Zoom. Now, press-and-hold the Shift key, press Z to switch to the Magnifying Glass tool (okay, it's called the Zoom tool, but its icon looks like a magnifying glass), and click-and-drag a selection around a person or object in one of the active image windows. You'll notice that all four photos jump to the same zoom. Note: If the Resize Windows To Fit feature is selected in the Zoom tool's Options Bar, this won't work properly.
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Step Four

Now go under the Window menu, under Images, and choose Match Location. Press H to switch to the Hand tool (it's right under the Zoom tool in the Toolbox), press-and-hold the Shift key, then click within your image and drag to pan around your photo. If you don't hold the Shift key first, it will just pan around the front-most active window. By holding Shift, all the windows pan at the same time and speed, enabling you to compare particular areas of your photos at the same time.
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Reducing Clutter by Stacking Your Photos

This is one of my favorite features because it lets you reduce "photo clutter" and makes things more organized when working in the Photo Browser window. It's called "stacking," and it lets you stack similar photos together, leaving just one photo to represent a stack of photos. So, if you took 120 shots and you've already sorted the best of the bunch into a collection, you don't have to have 120 shots cluttering up your catalog. Instead, you can have just one representative photo, and underneath it are the 119 others.



Step One

With the Organizer open, press-and-hold the Control key on your keyboard and click on all the photos you want to add to your stack (or if the images are contiguous, simply click the first image in the series, press-and-hold the Shift key, and click on the last image in the series). Once they're all selected, go under the Organizer's Edit menu, under Stack, and choose Stack Selected Photos in the submenu.
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Step Two

No dialog appears, it just happens—in this case, your three other photos now are stacked behind the first photo you selected (think of it as four layers, and on each layer is a photo, stacked one on top of another). You'll know a photo thumbnail contains a stack because a Stack icon (which looks like a little blue stack of paper) will appear in the upper-right corner of your photo. You'll also see a right-facing arrow to the right of the image thumbnail.
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Step Three

Once your photos are stacked, you can view these photos at any time by clicking on the photo with the Stack icon, and then going under the Edit menu, under Stack, and choosing Expand Photos in Stack, or just click on the right-facing arrow to the right of the image thumbnail. This is like doing a "Find," where all the photos in your stack will appear in the Photo Browser window within a gray shaded area so you can see them without unstacking them. Then, to collapse the stack, just click on the left-facing arrow that appears to the right of the last image thumbnail in the stack.
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Step Four

If you do want to unstack the photos, select the photo with the Stack icon in the Photo Browser window, then go under the Edit menu, under Stack, and choose Unstack Photos. If you decide you don't want to keep any of the photos in your stack, select the photo with the Stack icon in the Photo Browser window, go back under the Edit menu, under Stack, and choose Flatten Stack. It's like flattening your layers—all that's left is that first photo. However, when you choose to flatten, you will have the choice of deleting the photos from your hard disk or not.



[image: image]



Putting Your Photos on the Map!

If this isn't cool, I don't know what is. Imagine being able to send friends or relatives to an online customized version of Yahoo! Maps, and when they click on a map pin, they see your photos, and the exact location where they were taken on the map. Seriously, is that cool or what? A totally interactive online map you create and link to your own photos at the spot where they were taken. Now, come on, if it doesn't sound that cool, then you've got to try it once and you'll be totally hooked.



Step One

You start by going to the Organizer and switching it into Map mode by clicking on the Map icon at the bottom of the Organizer (as shown here). This splits the screen, and shows your photos on the right side, and a Yahoo! map of North America on the left side. (By the way, since this whole Yahoo! Maps thing is Internet-based, I guess it goes without saying that you need to have an Internet connection, right? Right.)
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Step Two

Now let's create a custom tag for the photos you want to appear on a certain city on the map. For example, let's say that you've got a number of photos taken from your vacation in Miami, Florida. You'd start by creating a new tag (in the Organizer portion of the screen) and then link that tag to a particular city on the map (don't worry, it's easier than it sounds). Start by clicking on the Tags button in the Organize Bin on the right side of the Organizer. Then click the New button and choose New Tag from the pop-up menu. When the Create Tag dialog appears, name this tag Miami (as shown here), but don't click OK yet.
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Step Three

Now click on the Place on Map button, which brings up a dialog asking you to enter the location where the photos where taken (in this case, I just typed in Miami, FL), then click the Find button (as shown here).
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Step Four

This brings up the Look Up Address dialog, where it queries its database to find a match on the map. Luckily, Miami's a pretty popular place, so in less than a second it popped up with "Miami, FL, US." If that's the city you're looking for (and we are), click OK. However, you can get a lot more exact than just this. I typed in my exact home address, and it pinpointed it exactly on the map, so don't be afraid to get really precise if you know the exact address of where the photos were taken. In fact, let's go ahead and enter the exact address of the Marseilles Hotel (a very cool art deco hotel in the heart of South Beach). Its address is 1741 Collins Ave., Miami Beach, FL. So click on the Place on Map button again, but this time enter that new address, and then click the Find button. It will find it right away, so once it appears (in about two seconds), just click OK, and you'll notice that the map on the left side of the window zooms into that exaction location on Collins Avenue in Miami Beach. Pretty slick. But we're not done yet. Change the name of your tag to Miami Beach, and then click OK. When you do this, you'll see a red pin appear, marking the exact location you entered on the map.
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Step Five

Now, in the Organizer, select the photos you want to tag with your Miami Beach tag (hold the Control key and click on each photo you want selected), then click directly on the tag in your list of tags, and drag-and-drop that tag onto one of your selected photos. (By the way, if you previously tagged images with a tag that contains an exact address, you can simply click-and-drag the photos with that tag to a spot on the map.)
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Step Six

Want to make sure this process really worked? Then move your cursor over the red pin on the map, and click once. A mini slide show viewer will appear, and you can click on the tiny thumbnails below the main photo to see individual photos, but that's not the cool feature. Go ahead and click on the main photo, and you jump straight into an instant full-screen slide show of the photos you tagged with that tag, and are pinned at that map location (see, I told you this was cool). To leave the slide show and return to the Organizer, just press the Escape key on your keyboard. Seeing the photos on your own computer is one thing, but now let's get these up on the Web so other people can see them. That's when it gets really fun.
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Step Seven

To share these map photos (and the map itself), you simply click once on the Share button located just below the bottom-right corner of the map. You'll get a dialog that lets you know that if you share the map, it means you agree to Yahoo! Maps API's terms of service. Go ahead and click Share. This brings up the Photo Galleries Wizard (yup, this is the same Wizard you use to create websites, and the reason you're using this is because your Yahoo! map will be Flash-based, just like Elements 5's other interactive Web galleries). On the left side of this dialog, you'll enter your gallery title, a text caption (if you like), and then some descriptive text in the About This Gallery text field. Below that, enter your name and email address.
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Step Eight

To see a preview of your finished Map, click the Preview in Browser button, and it launches your Web browser and displays your interactive map. If you click on the red pin, it shows the photos attached to that pin, just as it did in the Organizer. If you click on one of the photos, it starts the Flash-based slide show. To return to the map, click the small Map icon at the bottom of the window. To return to Elements 5, close your Web browser. To put your final map on the Web, go to the Save and Share section at the bottom of the Photo Galleries Wizard, and choose where you want to save this (to your website, the free Photoshop Showcase website, or even to CD) from the Share To pop-up menu, then click the Share button at the bottom of the dialog to complete the process. Now you can point friends and family to your new interactive map-based online photo gallery. Cool!
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End of sample




    To search for additional titles please go to 

    
    http://search.overdrive.com.   
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